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Fastcase for Bar Associations — An Introduction to fast

Because Fastcase is committed to providing valuable content for our partners, we created Fasttips —an
easy way for partners to communicate with members about Fastcase. Included is a set of more than 20
tips associations can use to make sure members know about all the perks of the Fastcase member
benefit. We formatted the tips in two ways — for the blog or the newsletter and for Twitter (all the URLs
link to full posts on the Fastcase blog). Everything is ready to use — it’s that simple.

Advance Sheets

Fastcase’s Advance Sheets in e-book format provide you with one month’s worth of judicial opinions
from courts around the country. The Fastcase collection will work on most e-readers, including iPad,
Kindle, Nook, and Android tablets. Because the opinions are in e-book form, they’re searchable and text
can be highlighted, shared, annotated and read anywhere. The e-books are free — just download them
in iTunes, Amazon, or Google Play!

http://www.fastcase.com/ebooks/

Fastcase for iPhone, iPad, and Android

Take smarter legal research on the go with Fastcase for iPhone, iPad, and Android! Search caselaw and
statutes using our smart search technology. You’ll also be able to use many features you’re familiar with
from our Web-based legal research application, such as seeing the most relevant results at the top of
the list, customizing and re-sorting search results, and the integrated citation analysis tools.

http://www.fastcase.com/iphone/
http://www.fastcase.com/android/

Mobile Sync

Connect your iPhone, iPad, or Android accounts with your desktop account, bringing together your
favorites and usage history. Plus, when you save cases on the go, you can access them through your
desktop where it’s easy to print, find expanded search information, and access support from Fastcase
reference attorneys and technical professionals.

Instructions are available at http://www.fastcase.com/mobile-sync/
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Survey Statutes in Multiple Jurisdictions
Fastcase offers a variety of searchable databases to help you find cases and statutes quickly and easily.
One of Fastcase’s features is the ability to search statutes across multiple jurisdictions, allowing you to

survey a topic across our statutory collection.

Example: If you are looking for statutes about how custody relates to the best interest of the child, you
could follow these steps:

1. Select Search Statutes from the Search menu on the homepage.

2. In the grey search bar near the top of the page, enter the following: child custody and “best interest”
3. Click the Select All button under the list of current statutes.

4. Select Search.

5. You will then see a list of all the statutes that reference custody and best interest of the child. The
results will be listed by relevance (the sections containing the most detailed discussion of the issue will
be listed first).

6. You may now click on the title of a section to view it individually.

Note: Filter your results by jurisdiction if you find the results too broad; in this instance if you were only
curious about Missouri cases, you would locate the “Filter by:” box in the top left corner of your screen,

and select Missouri from the drop-down menu.

You may then print your desired results, add them to your print queue, save them to your library, or
email them to your colleagues.

Choose how you print

Ever print something from a website and find that some of the page has been cut off or the URL is
printed across the bottom of the page? Fastcase allows you to print clean, single or dual-column Word
documents, PDF documents, or WordPerfect-compatible rich text format documents.

Here’s how to do it:

1. Once you’ve found your case, click the Print/Save link located in the gray bar above the case.

Choose your preferred number of columns in the “Number of Columns” drop-down box.

3. You can also choose whether to print the document from Microsoft Word or Adobe Acrobat
in the Format drop-down box.

4. When you've selected all your preferences, press Print/Save and your document will open in
Microsoft Word or Adobe Acrobat.

5. From here, you can save the document and print it later or print it right away.

N
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User Guides Available
New to Fastcase? Need a refresher on basic features? Download one of training guides. There’s a one-
pager for quick reference as well as a more comprehensive multi-page version. You can find both in the

Help & Training section on the corporate homepage.

www.fastcase.com —> Help & Training = Documentation & Downloads

Watch a Fastcase Video Tutorial

When it comes to navigating a new web-based service, sometimes the best way to learn is by seeing.
Fastcase has a library of 30 second to 5 minute video tutorials that will take you through finding and
viewing cases and statutes, printing, and using advanced features like Authority Check and the
Interactive Timeline. You can watch these videos, on demand, anytime you need them. Visit
www.fastcase.com/video.

Batch Printing
Did you know that you can print up to 20 cases at a time with Fastcase? Here’s how:
1. Add documents to your print queue. Add documents to your print queue one of two ways.

From the results page: Each case on your results list has a Print Queue icon to the left
of the screen. The Print Queue icon looks like a printer with a plus sign on it. Click on
the Print Queue icon to add a case to your queue. When the case has been added, the
plus sign on the icon will turn into a minus sign.

While browsing a case: Click on the Add to My Print Queue link at the top right of the
screen.

2. Review your queue. To review your print queue, select View Print Queue from the Print menu.
To remove the case from your print queue, click on the icon again.

3. Print. Once you have made your formatting selections, click the Print/Save button. The cases
listed on your print queue will begin downloading as a single document on your computer.
Open the file using the appropriate program (e.g., MS Word, Adobe Acrobat, Word Perfect) and
then print the document by selecting Print from the File menu.

Browse Statutes in Outline View

——
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With electronic sources, sometimes the fastest way to find the statute section that you are looking for is
to browse the statute in Outline View. Using Outline View on Fastcase, you can see the structure of the
entire statute and easily toggle back and forth between different subsections.

Example: If you wanted to browse the U.S. Code to find 42 U.S.C. § 1983, you would follow these steps:

1. Select Search Statutes from the Search menu.

2. Above the text box, there are two tabs, a Search tab and a Browse tab. Click on the Browse tab.

3. Alist of our searchable jurisdictions will appear. Select U.S. Code from the list of statutes and
jurisdictions by clicking on the plus sign next to “United States Code.” This will bring you to an
expandable outline of the U.S. Code. Choose which edition of the U.S. Code you want to search
by clicking on the plus sign next to the applicable edition.

4. Initially, you will see a list of the Titles within the Code. Click on the plus sign next to each Title
to view the Chapters within each Title. Then click on the plus sign next to Chapter to view each
Section.

a. Scroll down and expand Title 42 The Public Health and Welfare.

b. Then scroll down and expand Chapter 21 Civil Rights.

c. Finally scroll down a bit further and click on Sec. 1983. Civil action for deprivation of
rights.

The statute text is in the panel on the right while the outline of the statute remains in the panel on
the left.

Constructing a Broad Keyword Search

When you are getting started on a new research project, it is usually a good idea to start with a broad
search query and then narrow your query until you get an acceptable number of results. Use these tips
to make sure you are not inadvertently excluding decisions that address your topic.

1. Usesynonyms. Try including common synonyms for the keywords in your query. For example,
if one of your search terms is car, include automobile and vehicle in your search as well.

Instead of: “fourth amendment” & car

Try: “fourth amendment” & car or “fourth amendment” & vehicle or “fourth
amendment” & automobile

2. Use the wildcard operator. By truncating a search term down to the root of the word and
adding an asterisk at the end, your search with automatically pick-up multiple forms of the word
including plurals. For example, a search for contract™ will pick-up all of the following terms:

——
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Contractor, contracting, contracts, contracting, contracted, etc.
3. Avoid quotation marks. Rather than putting a phrase in quotation marks, try constructing a
query using keywords in the phrase connected with the within operator. This will reduce the
chances that you are excluding cases that use slightly different words.

Instead of: breach of contract

Try: breach w/3 contract because this picks up phrases like breached its
contract, breach of the contract, etc.

Copy Citation
Don’t let the tedious process of copying down case citations sidetrack your research project. Instead,
use the Copy Citation function in Fastcase to automatically copy and paste the citation of the case you

are quoting into the document you are working on. Here’s how it works:

Step 1:  Access the case that you want to cite. Make sure that you are in the full case text view and
not on the results screen.

Step 2:  Select Copy Citation from the Document menu.

Step 3: Open the document (or e-mail) that you want to paste the citation into. Put your cursor in the
appropriate spot in the document and press Ctrl + V.

Voila! The case citation will be pasted into the document.

Please note that at present, this feature is only compatible with Internet Explorer.

E-mail a Case

You asked for it and Fastcase delivered. In response to popular demand by our users, we recently rolled
out our e-mail feature which allows you to e-mail a case to yourself or to your colleagues or clients. Just
follow these simple steps:

1. When you are browsing a case, simply click on the Email link towards the upper right hand side
of the page.

2. This will bring you to the E-mail Document Window. Here you can enter in the recipient’s e-mail
address. The e-mail address you used to register with Fastcase will always be filled in by default,
but you can click in the Send E-mail To: box and change the e-mail address to anything you like.

3. Click on the Send Email button. That’s it! The case you selected will be delivered shortly. The e-
mail will be from support@fastcase.com and the case text will be in the body of the e-mail.
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Remember: To ensure that Fastcase e-mails are not caught by your junk e-mail or spam filters,
add support@fastcase.com to your list of trusted senders.

Filtering Search Results by Jurisdiction

When you generate a list of case law search results on Fastcase, you have the ability to filter the list to
cases from just one jurisdiction.

For example, let's say you search for "felony murder" in all Federal Appellate Courts. You will get at
least 1,000 results.

If you want to view only the decisions of the Ninth Circuit Court of Appeals, there is no need to re-run
your search in the Ninth Circuit database. Instead, just select "Federal 9th Circuit" from the Jurisdiction

filter at the top, left hand side of the screen.

Your results list will go from 1,000 results down to the 200-or-so results from the Ninth Circuit. The
other cases will be temporarily hidden.

Get the full list instantly by selecting "All Jurisdictions" from the drop-down Jurisdiction filter.

Harness Authority Check’s Citation Analysis to Find Authoritative Cases Quickly

Did you know that you can use Fastcase Authority Check to help you find the most authoritative cases
on your research topic? In fact, if you are not taking advantage of Authority Check’s second level of
citation analysis — citations within your search results — you may be missing out on valuable information.

Follow these quick and easy steps to get the most out of Authority Check and find authoritative cases
quickly.

1. Perform a search using the Advanced Case Law Search. Make sure that the box next to “Show
Number of Citations in Search Results” is checked at the bottom of the page.

2. When you get to the Results screen, you will see a column labeled “Authority Check” on the far
right of the screen. Under that heading, there will be a blue hyperlink that reads “These
Results.” Click on the link.

3. After you click on the link, your search results will be sorted by the number of times they have
been cited by other cases within your search results. In other words, the most authoritative
cases — those relied on most heavily by other cases within your search results — will be at the top
of the list.

Highlighting Search Terms

——
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By default, Fastcase automatically highlights each instance of all of the search terms in your query. If
you would prefer to view your case with only one of your search terms highlighted, select the relevant
term from the Highlight menu at the upper left hand side of the screen.

Example:

If you search for busing AND desegregation every instance of the words busing and desegregation will
be highlighted within each of your search results.

If you want to see your search results with the word busing to be highlighted but not the word,
desegregation, then select busing from the menu next to the label “Highlight”.

You will find this option towards the top, left hand side of the screen when you are viewing the full text
of the case.

Jump to the Most Relevant Paragraph in a Case

Fastcase helps you search smarter by allowing you to jump to the most relevant paragraph in a case with
one click. When browsing a case, just press the M key. Alternatively, you can click on the Jump to the
most relevant paragraph link at the top of the screen. You will automatically be directed to the
paragraph of the case that is most relevant to your search terms. Use this feature to move through your
search results more efficiently and focus on the cases that are important to you.

Note: This feature is currently only enabled when using Internet Explorer.

Learn to Use Boolean Operators

The most powerful and flexible way to search for cases on Fastcase is to perform a keyword search using
Boolean operators.

Boolean operators are symbols that tell a search engine how to relate keywords to one another. For
example, there are many ways to relate the two keywords Cat and Mouse.

— Cat AND Mouse

This search will yield cases containing both the words Cat and Mouse.

— Cat OR Mouse

This search will yield cases containing at least one of the words Cat or Mouse.
— Cat NOT Mouse

This search will yield cases containing the word Cat but not the word Mouse.

——
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— Cat w/5 Mouse
This search will yield cases containing the word Cat within 5 words of the word Mouse.

Fastcase’s search engine is compatible with 7 simple Boolean operators. Don't worry, there is no need to
memorize them. We display each operator along with examples right below the search box on the
Advanced Caselaw Search page.

If you are new to Fastcase, a good way to learn how to use these operators is to click on one of the blue
hyperlinked examples in the search tips. This will paste the search query in the example into the search
box. Then you can press search to see what the results look like and compare them to the description of
expected results listed in the search tips box. We are confident that with a little practice, you will
become an expert in keyword searching in no time!

Print a List of Your Search Results

Printing a list of your search results is easy with Fastcase. Just click on the Print List of Results link at the
top, middle, portion of the screen. This will automatically trigger your browser's print function and print
the first page of results on your list.

To print the next page, click the blue arrow to the right of where the number of results is listed, and click
Print List of Results again.

Hint: You can print a list of up to 100 results at once by increasing the "Results per page" setting to 100
on the Advanced Case Law Search page. By default, this is set at 20.

Retrieve Your Favorite Cases Anywhere

Use Fastcase to create your own personal library of up to 50 favorite cases with just one click. Once you
have added cases to your library, you can access them easily anytime without searching.

e To add a case to your library, just click on the link labeled Add to My Favorites at the top right
hand side of the screen.

e To access the cases in your library, just select Go To Favorite Documents from the My Library
menu.

Bonus: Did you know that Fastcase automatically saves the last 10 cases you have accessed in your
library? To access this personalized case history, simply select Go to Recent Documents from the My
Library menu.

Search for a Case Using the Party Names
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Did you know that you can easily look up a case using the party names? Fastcase’s Keyword Search is
the perfect tool for this type of search.

Example: Curtis Publish. Co. v. Butts, 388 U.S. 130 (1967).

1. Navigate to Advanced Case Law Search by choosing Search Cases from the Search menu.

2. Choose one unique word (e.g. avoid words like “Inc.” and “Corp.”) from each party name and
construct a within search as follows:

Curtis w/15 Butts

3. If you know which jurisdiction issued the decision you are looking for, narrow your search
accordingly and then press search.

4. The case you are looking for will almost certainly show up in your top 10 search results. In this
example, the case we selected was the first case on the list.

Selecting a Specific Jurisdiction
With Fastcase, it is easy to choose a specific jurisdiction for your case law searches.
1. Start by navigating to Advanced Caselaw Search.

2. Next, scroll down to the “Select Jurisdictions” heading and click the circle next to “Individual
Jurisdictions.”

3. This should reveal a number of categories of jurisdictions. Expand any category by clicking the plus
sigh next to the category name.

4. Select the specific jurisdictions you wish to search within by marking the box next to the name of the
jurisdiction. You can select as many or as few as you like, and you can search across different
categories.

Bonus: Asyou search, the last 5 jurisdictions (or groups of jurisdictions) that you selected will begin to
appear under “Recently Searched Jurisdictions.”

Send Your Search Results to Another Fastcase User

At Fastcase, you get static urlst for all search results (and cases). That means you can save search
results as bookmarks or send them to other Fastcase users. Just follow these simple steps to send your
search results to another Fastcase user:

1. Run a search.
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2. When you are on the results screen, copy and paste the url into an email and send to the
desired recipient.

3. Your recipient can access your search results by copying and pasting the url into her browser
window after logging in to Fastcase.

TNot sure what a urlis? “Url” stands for “uniform resource locator.” Think of it as a type of address
that tells your web browser where to access information from within Fastcase. Urls are displayed in the
address bar (usually at the top) of your web browser. Fastcase urls begin with: “https://.”

Sorting Cases to Find Results Faster

Fastcase allows you to search broadly and then sort your search results to find what you need quickly.
In fact, you can sort your case law search results in 6 different ways. Make your selection on the
Advanced Caselaw Search page under Search Options, then Results, then Sort by. Most of these sorting
options are also available on the Results screen.

Sorting Options:

Relevance: This is the default sorting order, so if you don’t make a selection, this is the
order that your results will appear in. The higher the Relevance percentage (0-
100%), the more likely a case is to contain a substantive discussion of your topic.

Case Name: Sorting by case name will put your results in alphabetical order.
Decision Date: Sorting by decision date will put your results in chronological order.
Court Hierarchy: Sorting by Court Level or Court Hierarchy will put your results in order according

to the level or the court issuing the decision, starting with U.S. Supreme Court
decisions and ending with State Supreme and Appellate Court decisions. Note:
this sorting option is only allowed on the Advanced Caselaw Search page.

Cited Within: Sorting by “Cited Within” will put your results in order of the number of times
each decision was cited by other decisions in your search results. Note: This
category is called “These Results” on the Results screen.

Cited Generally: Sorting by “Cited Generally” will put your results in order of the number of
times each decision was cited by other decisions in the Fastcase database.
Note: This category is called “Entire Database” on the Results screen.

Use Live Chat for Assistance with Your Research

At Fastcase, the mission is to help you work smarter, not harder. Our live customer support is an
important part of this mission and Live Chat is one of the best ways to take advantage of this service.
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It works just like an instant-messaging program and allows you to get personalized help while multi-
tasking at the same time. What’s more, Fastcase customer support associates can even send you links
to search results, cases, and more via Live Chat making it one of the most efficient ways to get
assistance.

To access Live Chat, just select Live Help from the Help menu at the top of the screen. A Live Chat
window will open on your screen. Here you can type in your question and wait for a Fastcase customer

support associate to respond.

Live Chat is available from 7 am to 7 pm Central time, Monday through Friday, excluding holidays.

Using Forecite for Smarter Search Results

Fastcase just unveiled a brand new citation analysis tool called Forecite that helps you get even more
out of your keyword searches. Now, every time you perform a keyword search, Forecite will analyze the
citation structure of the cases in your search results and suggest additional cases to you. These
suggested cases will not be in your ordinary search results because they may not contain all of your
search terms. However, they are cases that cited frequently by other cases in your search results, and
are therefore likely to be highly relevant to your research topic.

Here’s an example to help flesh out how Forecite works.

Research Topic: Desegregation and busing laws

If you were researching desegregation and busing laws, your research certainly would not be complete
without considering the Supreme Court’s seminal decision in Brown v. Board of Education, 347 U.S. 483

(1954). However, if you search using those terms — desegregation and busing — Brown will not be in
your search results because it does not contain either of those terms.

No need to worry though, Forecite has you covered.

When you perform this search on Fastcase, you will see a light orange colored banner at the top of your
search results screen that indicates that in addition to your regular search results, Fastcase Forecite has
identified 2 more decisions that may be relevant to your topic. Click the arrow at the right to expand
those results. These 2 decisions are both seminal and relevant cases — Brown v. Board of Education, 347
U.S. 483 (1954) and the follow up decision, Swann v. Board of Education, 402 U.S. 1 (1971).

Use Your Browser to Develop a Library of Your Favorite Searches

You may already know that Fastcase automatically tracks your last 10 searches. But have you ever
wished that you could access even older searches? How about naming your searches and organizing
them in folders by topic? You can easily accomplish all of these tasks using your web browser.

1. While on the Results screen, press Control + D. (Mac users, use Apple/Command + D instead).
This will cause a small window to appear on your screen.
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e |nlE: “Add a Favorite.”
e |n Firefox: “Page Bookmarked.”
e |n Chrome: “Bookmark Added.”

2. The window will prompt you to name your bookmark. Name your bookmark according to your
search topic, e.g., “Miranda Fifth Amendment.”

3. Next, follow the prompts in the bookmark window to create a new bookmark folder for your
search. (Hint: Try creating folders for particular clients or briefs, e.g., “Merits Brief” or “Smith
Arbitration.”)

4. Toreturn to your bookmarked search results later, find the bookmark folder you created using
your browser. When you click on the bookmark, your search results will automatically reappear.

(Hint: Make sure you are logged in to Fastcase before accessing your bookmarks).

Using the Wildcard Operator

The wildcard operator is one of the most powerful Boolean operators in your toolkit. At Fastcase, we
use the asterisk symbol (*) as our wildcard.

When you put the asterisk after the stem of a word, your search will return documents containing any
word beginning with that stem.

For example:

Termin* 2> Search results containing the words termination, terminated, terminal, etc.
Litig* 2> Search results containing the words litigator, litigation, litigious, etc.

Eat* 2> Search results containing the words eat, eaten, eatery, eaters, eating

As you can see, using the wildcard operator is a very powerful and flexible tool. Think about
incorporating the wildcard regularly in your searches.

Condense Research Notes into One Easy-to-Use Document

It’s often helpful to have your comments and analysis in one place for easy reference. To create such a
document using Fastcase, follow the simple steps below:

Identify the relevant cases and save them as one file using the batch printing feature so that you can
easily maneuver from one case to the next. Open the case either as a document in Microsoft Word or as
a PDF in Adobe Acrobat.
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Go through the document and identify key issues, facts, and legal points. Then if you’re using Adobe,
highlight the passages or words of interest and annotate with sticky notes. If you’re using Word,
highlight the passages and annotate using Review = New Comment.

To view all your notes in a concise format, hit “comments” (if you’re using Adobe) in the upper right-
hand corner and they will appear in a side tab. In Word, go to Review = Reviewing Pane and they will
appear in a side tab.

To print just the notes, go to Print > Summarize Comments in Adobe, or Print > List of Markup in
Word. This way you’ll have all your comments at hand, labeled with the page and paragraph they refer
to. This is an easy way to create a master document that you can use to dictate your brief, statement of
facts, statement of the law, or argument.

Hat tip to J. Burton Hunter Il who shares this tip on his blog “A Small Town Lawyer.”

Visit him here: http://burtonhunteresq.blogspot.com/2011/07/practical-technology-102.html

Free advance sheets for your e-reader are searchable, editable, and can be read anywhere.
http://bit.ly/KkMWUuE

Learn how to search statutes across multiple jurisdictions. http://bit.ly/N1L60G
Print cases in single or dual-column DOC, RTF, or PDF format. http://bit.ly/OEAurN
New to Fastcase or need a refresher on basic features? Download a guide! http://bit.ly/qgAcIX

Check out the Fastcase library of 30 sec to 5 min on demand video tutorials to make research even
easier! http://bit.ly/oEwMgG

With Fastcase you can print up to 20 cases at a time. Add docs to print queue, review queue, print!
http://bit.ly/pdLezN

With Fastcase, Outline View makes browsing statutes easy. Click ‘Browse’ to see the outline view.
http://bit.ly/nl110Xc

Keyword Search tips: use synonyms (car/automobile), use wildcard operator (*), avoid quotation marks.
http://bit.ly/nAbcyC

Fastcase copy cite function: Open case, “Copy Citation” from Document menu, Ctrl+V pastes citation
into Word or email. http://bit.ly/psGoPU

Emailing a case on Fastcase? Click email link in top right of page, enter email address, send!
http://bit.ly/oJHIBu
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Using Fastcase, run a broad search search and filter to just one jurisdiction to narrow results.
http://bit.ly/pnQAIV

On the search results screen, click "These Results" under Authority Check to view most-cited cases
within your search. http://bit.ly/qyGD1k

Looking to focus one on search term on Fastcase? Choose a single term from the highlight menu above
the case. http://bit.ly/mSAxoM

Search Smarter —Jump to most relevant paragraph in a case. Just Hit Ctrl+M (IE only)
http://bit.ly/mUNOIP

Use Boolean Operators (AND, OR, NOT, w/5 — within 5 words) for more powerful searches.
http://bit.ly/oc8lh3

To print a list of your search results, increase results per page and click “Print Results.”
http://bit.ly/p6d83M

Did you know you can search Fastcase by party names? http://bit.ly/ruT7tz

Get accurate results by specifying a jurisdiction. Select any combination of jurisdictions on Fastcase.
http://bit.ly/nNinS4

Send searches to another Fastcase user: search, copy & paste url into email. Voila! http://bit.ly/nQzCgM

Sort cases by relevance, case name, decision date, court hierarchy, cited within, or general citation.
http://bit.ly/riTAXG

Use Live Chat for customer support: M-F 7a-7p Central. Multitask while getting research assistance.
http://bit.ly/nOp04a

Fastcase Forcite recommends additional cases likely to be relevant to your research topic.
http://bit.ly/rhWhpE

Save searches by adding them to your Favorites (IE) or Bookmarks (Firefox, Chrome). Access them any
time! http://bit.ly/pW4Afd

Give the wildcard a whirl (*). Ex: eat® = search results contain eat, eaten, eatery, eaters, eating.
http://bit.ly/oeNU9B

Tip: Condense research notes into one easy-to-use document. http://bit.ly/qdZvdW

Take your legal research on the go with Fastcase for iPhone, iPad (http://bit.ly/aHeaOw) and Android
http://bit.ly/Ke8B9b

Mobile Sync will connect your mobile app with your desktop account. http://bit.ly/y4UrUh
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Store up to 50 of your Favorite Cases - click "Add to My Favorites" at top right of screen.
http://bit.ly/rlvbXg

Using Fastcase, access your favorite cases in your library — select Go To Favorite Docs from My Library
menu. http://bit.ly/rlvbXg

Fastcase auto-saves the last 10 cases you accessed. Select ‘Go to Recent Docs’ from ‘My Library’ menu.
http://bit.ly/rlvbXg
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